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■ ABOUT THIS USER MANUAL
You will find all the information you need to install and 
use the UM185US in this user manual. Before using the 
UM185US, you must properly install the U.S. Cellular® 
Broadband Connect by closely following the installation 
instructions.

INSTRUCTIONS
•	 The software needed to install and configure your 

UM185US USB device is already included on the device.

•	 It is highly recommended that you read the safety 
precautions described in this manual before using the 
UM185US.

n	� This User Guide is described for Windows-based users. User 
interfaces may be slightly different for Macintosh.

■ PRODUCT OVERVIEW 
Thank you for purchasing the U.S. Cellular Wireless 
UM185US USB Modem. The UM185US is a 3G wireless device 
that enables high-speed wireless communication from your 
laptop or desktop computer. The UM185US is simple to 
install and use.

■ WHAT’S INSIDE THE PRODUCT PACKAGE
The following items are included in the product package. If 
any of the items listed below are missing, please contact the 
retail location where you purchased the product.

•	 UM185US Wireless USB Modem

•	 Quick Start Guide

ABOUT THIS USER 
MANUAL
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■ �INTRODUCTION TO U.S. CELLULAR UM185US 
WIRELESS USB MODEM

The U.S. Cellular UM185US is designed for your laptop or 
desktop computer’s USB port, which is available in most 
models. The UM185US can be used to access the Internet, 
your company’s intranet, or you can use it to send and 
receive email. It is extremely useful when you are away from 
the office, on the road, or wherever a wireline Internet 
access is not readily available.

n	� Blue light: Connected to laptop or desktop computer and 
detected to network  
Red light: Connected to laptop or desktop computer but out 
of service status

INTRODUCTION TO 
UM185US USB MODEM

USB Connector

External Antenna 
Booster Jack 

(on the back side)

LED status  
indicator *
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■ PRODUCT FEATURES
•	 Power management: The UM185US utilizes power 

management and system overhead reduction functions 
provided by the USB interface for maximum power 
savings.

•	 Antenna design: Efficient, innovative internal antenna 
design optimizes data transfer rate and sensitivity to 
network signals.

•	 USB Modem that supports Type A USB Port interface.

•	 Supports North American US_PCS, Wireless CDMA and 
AWS bands.

•	 Utilizes QUALCOMM QSC6085 chipset.

•	 Supports 3G network technologies.

•	 Maximum Data Rate: 3.1 Mbps download; 1.8 Mbps 
upload.

•	 Supports Windows XP, Vista and 7 systems with installed 
host software and driver.

•	 Compatible with Mac OS X 10.4.11, 10.5 or 10.6.

•	 Provides U.S. Cellular Wireless Modem service. 

•	 The datacard cover automatically closes when you push 
the designated point as displayed in the following figure.

	

•	 When using the UM185US, please slide the black USB 
cover UP for the best reception.

PRODUCT FEATURES
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■ PRODUCT HANDLING
1	 Do not put any adhesive label on the USB connector. It 

may leave a sticky residue that can cause problems inside 
the USB port.

2	 The UM185US USB device should easily slide into the 
USB port. Do not force the UM185US into the USB port 
as it may cause damage to the modem and/or the port.

3	 Keep the UM185US in a dry and clean place. (Storage 
temperature: -22°F to 149°F [- 30°C to 65°C]).  
Keep your device away from liquids, dust and excessive 
heat. 

■ CONFIGURATION
To use the UM185US, you should first install the software 
included on the device and configure the UM185US USB 
device. See the next section for more information on 
software installation and USB device configuration.

PRODUCT HANDLING 
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INSTALLING UM185US

■ PRECAUTIONS 
•	 Once the modem has been inserted into the laptop 

or desktop computer, do not remove it without first 
completing the unplugging/ejection process. 

■ RECOMMENDED SYSTEM REQUIREMENTS
U.S. Cellular Broadband Connect operates in Windows® XP, 
Vista, 7 or Mac environments.

Check the following points in order to ensure the 
application works correctly:

•	 Minimum screen resolution recommended: 800x600  
256 colors.

•	 130MB available hard disk space for PC, 15MB available 
hard disk space for Mac.

WINDOWS XP SERVICE PACK 2 OR HIGHER
•	 300 MHz Processor or higher.
•	 512 MB of RAM recommended.
•	 Service Pack 2.

WINDOWS VISTA SERVICE PACK 1 OR HIGHER 
•	 PC featuring a Pentium® IV 2 GHz or better processor.
•	 512 MB of RAM recommended.

PRECAUTIONS
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WINDOWS 7
•	 PC featuring a Pentium IV 2 GHz or better processor.
•	 512 MB of RAM recommended.

MAC OS X 10.4.11, 10.5 OR 10.6

■ INSTALLING SOFTWARE 

INSTALLATION 
•	 If you install U.S. Cellular Broadband Connect, it will 

install the USB Driver for the UM185US. Follow the 
instructions from the U.S. Cellular Broadband Connect for 
installation.

WARNINGS!
•	 Make sure to complete the unplugging/ejection process 

BEFORE removing the UM185US. If you remove the device 
improperly, the product may be damaged.

n	• �If you have inserted the device properly, Windows will inform 
you of the new hardware. Wait until Windows completes 
the “Found New Hardware” task. In Windows XP, several 
tool tips similar to the “Found New Hardware” function 
will appear and disappear in the system tray automatically. 
In Windows Vista, several tool tips similar to the “Installing 
device driver software” function will appear and disappear 
in the system tray automatically. Once hardware detection is 
complete, you will be prompted to start activation.

	 • �For Mac OS, a device icon will appear on the desktop. Before 
unplugging the USB modem, be sure to move the icon to the 
trash for proper ejection.

INSTALLING SOFTWARE
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	 •  �It is normal to hear a short beep sound each time you 
insert or remove the UM185US. It is an audible notification 
that your laptop or desktop computer recognizes the new 
hardware.

n	� When removing the UM185US, always grip the top and 
bottom of the modem and push/pull carefully.

INSTALLING SOFTWARE
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SETUP

This chapter will guide you through the setup process for 
U.S. Cellular Broadband Connect. Before getting started, 
you should become familiar with the documentation that 
came with your wireless device.

GETTING STARTED (WIN)
Follow these steps to install U.S. Cellular Broadband Connect:

1	 Turn on your computer and close all applications.
2	 Insert the UM185US into the USB port.
3	 If set up does not automatically start:
	 a. Click the Start Button.

	 b. Choose My Computer.

	 c.  �Find and double click on the drive icon (U.S. Cellular 
Broadband Connect) that represents the data card.

4	 Follow the steps in the next section.

GETTING STARTED (MAC)
Follow these steps to install U.S. Cellular Broadband 
Connect:

1	 Turn on your computer and close all applications.

2	 Insert the UM185US into the USB port.

3	 Find and double click on the drive icon that represents 
the data card.

4	 Find and run the U.S. Cellular Broadband Connect icon 
in the MAC U.S. Cellular Broadband Connect folder.

5	 Double click the U.S. Cellular Broadband Connect icon to 
begin the installation.

6	 Follow the steps in the next section.

GETTING STARTED
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■ THE U.S. CELLULAR BROADBAND CONNECT
       SETUP PROGRAM (WIN)
STEP 1: To install on your hard drive, connect your device to 
your PC. The installation process will start automatically. 

Select the language for the installation from the choices 
below –  “English” or “Spanish” and click the “Next” button.

STEP 2: In the “U.S. Cellular Broadband Connect – License 
Agreement” screen, you will see the Program User License 
Agreement. In order to install and use this product, you must 
agree with the terms of this agreement. Select “I agree” then 
click the “Next” button to continue. If you do not agree with 
this agreement, click the “Cancel” button to exit.

THE U.S. CELLULAR 
BROADBAND CONNECT 

SETUP PROGRAM
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SETUP

STEP 3: After agreeing to the License Agreement, you will 
see the “U.S. Cellular Broadband Connect – Setup Type” 
screen. You can select from the two setup types – Express 
Install or Custom Install. It is recommended that you choose 
Express Install. Click the “Next” button to continue.

STEP 4:  During this step, the components of U.S. Cellular 
Broadband Connect are being installed onto your computer.

THE U.S. CELLULAR 
BROADBAND CONNECT 
SETUP PROGRAM
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SETUP

STEP 5: “The InstallShield Wizard has successfully installed 
U.S. Cellular Broadband Connect“ appears on the screen. 
Click the “Finish” button.

STEP 6: The setup program will create an Access shortcut 
and the U.S. Cellular Broadband Connect will launch 
automatically. Now the installation is complete.

THE U.S. CELLULAR 
BROADBAND CONNECT 

SETUP PROGRAM
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SETUP

■ �THE U.S. CELLULAR BROADBAND CONNECT SETUP 
PROGRAM (MAC)

STEP 1:  Double click the U.S. Cellular Broadband Connect 
setup program. 

When the pop-up screen appears to confirm installing the 
software, click the “Continue” button to continue with the 
installation process.

STEP 2:  The “Welcome” screen appears. Click the 
“Continue” button. 

THE U.S. CELLULAR 
BROADBAND CONNECT 
SETUP PROGRAM
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SETUP

STEP 3: The “Info & Manual” screen appears. Click the 
“Continue” button. 

STEP 4:  You are now ready to select the location on your 
computer where U.S. Cellular Broadband Connect should be 
installed.

THE U.S. CELLULAR 
BROADBAND CONNECT 

SETUP PROGRAM
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SETUP

STEP 5:  During this step the components of U.S. Cellular 
Broadband Connect are being installed onto your computer. 
Installation will occur to the destination folder specified in 
Step 4 above or you may change the installation location by 
pressing “Change Installation Location...”.

STEP 6: Installing the software requires you to restart your 
computer when the installation is complete. Please check 
that no other programs are running, then press “Continue 
Installation”.

STEP 7: While your computer is running the installer script, 
do not turn your computer off.

THE U.S. CELLULAR 
BROADBAND CONNECT 
SETUP PROGRAM
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SETUP

STEP 8: Select U.S Cellular Broadband Connect start-up 
option and click the “Continue” button.

STEP 9: Installation is now complete. Click the “Restart” 
button to leave the U.S. Cellular Broadband Connect setup 
program and restart your computer.

n	� To view the Guide go to Help > U.S. Cellular Broadband 
Connect Help.

THE U.S. CELLULAR 
BROADBAND CONNECT 

SETUP PROGRAM
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USING U.S. CELLULAR BROADBAND CONNECT FEATURES

Today’s online world offers more services everyday and 
U.S. Cellular Wireless gives you the tools you need to 
take advantage of the best in connectivity solutions. With 
U.S. Cellular Broadband Connect, enjoy the freedom and 
convenience of wireless Internet connectivity from your 
computer!

■ FEATURES

WWAN (WIRELESS WIDE AREA NETWORK, 1xEV-
DO/1xRTT) SPECIFIC FEATURES
•	 Configures your laptop or desktop computer to use your 

wireless device as a modem.

•	 Creates a U.S. Cellular Wireless Internet connection.

•	 Use to copy utility to create wireless copies of your dial-
up connections, if supported by your device.

•	 Displays signal strength for your Wireless USB Modem.

•	 Features a test function for your WWAN device.  
n	� A WWAN capable device is required to use the WWAN 

features. Individual WWAN features are also device  
dependent as described in the WWAN section above.

OTHER FEATURES
• �Can also be used to launch all of your dial-up networking 

connections, if desired.

• �Can launch your browser, e-mail client, VPN or a program 
of your choice upon connection.

• �Logs connections used, duration and bytes sent and 
received.



25
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• �See the section “Additional Features” for more 
information about the features of U.S. Cellular 
Broadband Connect.

■ GETTING STARTED
Double click on the U.S. Cellular Broadband Connect icon on 
your desktop or click on the Windows Start menu and select 
U.S. Cellular Broadband Connect from the list of Programs.

PC MAC

ABOUT THE NETWORKS VIEW
The U.S. Cellular Broadband Connect will open the 
Broadband Networks window by default. This view is where 
you manage your Broadband connections. The Broadband 
Networks window displays all currently available network 
connections.

At a glance you can see the signal strength. Your current 
connection state and the elapsed time of the connection are 
displayed.
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■ CONNECTING
U.S. Cellular Broadband Connect allows users to connect to 
the data network by clicking one button on the main UI. 
This can also be access by selecting the File > Connect to 
Internet.

To help ensure users data usage stays within their data 
plans, there is an option in the application to set U.S. 
Cellular Broadband Connect to disconnect the Internet 
connection after a specific amount of time or after a specific 
amount of data has been exchanged.

When creating the Internet connection, U.S. Cellular 
Broadband Connect must get the phone number from the 
device and include it as the username when needed. The 
Data Connection is accessed using the modem or over NDIS.

Once your device is properly configured, connecting to the 
Internet is as simple as selecting the network connection 
type shown in the list and clicking the Earth Shape Button.

Simply click this to end your current connection. To connect 
to any other network shown, select it, and then select 
“Earth Shape Button”.
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USING U.S. CELLULAR BROADBAND CONNECT

THE STATUS BAR
Information regarding your current network connection 
can be seen in the status bar along the bottom of the U.S. 
Cellular Broadband Connect interface. For more information 
on this status bar, see the section “The Status Bar” in the 
“Additional Features” section.

At any time during your connection you can check your 
current connection speed and throughput stats in the 
Statistics tab of the Session Information window. To see this 
window, select “Statistics” from the “View” menu.

The Connection Monitor window displays information about 
your data connection.

The Statistics section provides real time data throughput for 
current data connection. The Received tab provides received 
real time throughput.  The transmitted tab provides 
transmitted real time throughput.

The status section indicates the status, the duration and the 
speed of your connection. This information is required to be 
the same as the information displayed on the main screen.

The Internet Protocol (TCP/IP) button displays the Internet 
Protocol (TCP/IP) windows shows the Internet Protocol 
properties.

CONNECTING
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USING THE “DATA” CONNECTION:
By default U.S. Cellular Broadband enables the software for 
data connections. If your connection fails when you try to 
connect, please try to reconnect.

DORMANCY:
The data session becomes dormant if you are not sending 
or receiving any data. As soon as you resume sending or 
receiving data, the data session will return to an active state.

■ ADDITIONAL FEATURES
In addition to the basic features mentioned in previous 
sections, U.S. Cellular Broadband Connect has the additional 
features listed below.

CONNECTION STATUS
The text on the status bar reflects your current state. During 
an active connection, this text will change to “Connected”. 
If you are not connected, it will display “Not Connected”.

ADDITIONAL FEATURES
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USING U.S. CELLULAR BROADBAND CONNECT

WWAN USB MODEM STATUS AREA
The text can change to the following:

•	 Device not connected: Your WWAN USB Modem is 
removed from the laptop.

•	 Device not activated: Your USB Modem needs to be 
activated. Select “Update PRL” from the Options menu.

QUICK LAUNCH ICONS
• INTERNET – Launch default Internet browser.

• EMAIL – Launch default e-mail client.

• CONNECTION LOG – Launch Data connection logs.

ADDITIONAL FEATURES
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■ THE FILE MENU

CONNECT TO INTERNET / DISCONNECT FROM 
INTERNET
Allows you to manage your Internet.

EXIT
Exit the application.

■ THE VIEW MENU

STATISTICS
The main screen  shows you information about your data 
connection.  The data displayed is the Network Speed, 
Connection Duration, and the Bytes sent and received.  
This information is required to be pulled from the device, 
and not from Windows.

THE FILE MENU
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DATA CONNECTION LOG
U.S. Cellular Broadband Connect contains a log file of all 
connection made using the application. The data in the 
log can be easily sorted by connection, number, date/time, 
duration, bytes sent, bytes received, total bytes and status. 
The data will be taken from the device and then deleted 
on the device and stored on the PC. This ensures if the user 
connects outside of the software it is still recorded into the 
log file.

The data that are recorded and stored in the log file are 
Numbered Dialed, Call Duration, Bytes Sent, Bytes Received, 
Total Bytes, Date/Time of call, Disconnect Errors (Errors 
recorded are the Windows errors received when making the 
connection).

THE VIEW MENU
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TEXT MSG
U.S. Cellular Broadband Connect enables you to receive text 
messages. The Inbox displays the received messages. If there 
are unread messages, the unread messages are listed in bold 
and shown in the Inbox. For Windows users, the system tray 
also shows the green message icon which indicates there 
are unread messages in your inbox. The green message icon 
and the bold listings disappear as soon as you have read the 
message.

•	 Click File -> Open to view the message, or you can simply 
double click the messages listed in the Inbox.

•	 Messages are sorted by Contact, Date/Time, Type, Status, 
Size, Subject, or Callback number.

•	 Right click the messages to save as a text file. 

•	 You can print, change the status, or delete the messages.
n	� Text Msg function supports receiving text messages while your 

device is connected to the internet. Sending the text message 
is not available by using the Text Msg function.

THE VIEW MENU
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USING U.S. CELLULAR BROADBAND CONNECT

■ THE TOOLS MENU

GENERAL SETUP
General Setup allows users to make changes to the 
application. This section is split into multiple parts.

INTERNET CONNECTION TAB

This option allows users to change the Internet options.  
Here you can set U.S. Cellular Broadband Connect to 
disconnect after a specific amount of time or data. You can 
also set U.S. Cellular Broadband Connect to automatically 
retry the connection when the application starts but the 
connection fails. In the past the option to connect after the 
connection fails was dependent on starting the connection 
when the application starts. This needs to be changed to be 
two separate options.

In the When Connected section, select “Open Web Browser” 
and/or “Go To URL”. You can specify the URL to visit when 
the connection succeeds.

THE TOOLS MENU
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To set up automatic disconnect parameters based on data or 
time elapsed, go to the Launch Internet Connection section, 
click the “Manually” or “Automatically when application 
starts” button and follow these steps:

1	 Check the box.

2	 Then click the corresponding radio button to define 
specific amount of time or data.

3	 Use the scrolling list to select amount of minutes or Mb.

In the NDIS section, you can connect to the data network 
over modem or over NDIS. Check the box to use NDIS.

Move to another tab if necessary or click the OK button 
to confirm your choice. You can also set to connect 
automatically when the application starts and if the 
connection fails.

TEXT ALERTS TAB

This section displays the text alerts features. You can select 
the text alert sound and see where the sound file is located.

THE OPTIONS MENU
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Template: It shows what template is set for the text alert.

File: You can see where the sound file is located.

MISCELLANEOUS TAB

This section displays the start up features.  Here you can 
select to start Connection Manager on computer start-up 
and start with the ability to start the application minimized.

Launch U.S. Cellular Broadband Connect at Startup: 
Automatically launches U.S. Cellular Broadband Connect 
whenever you start your computer.

Start minimized: When you minimize the application it will 
now show in the task bar. To restore the application click on 
the U.S. Cellular Broadband Connect tray icon.

Automatically run U.S. Cellular Broadband Connect when 
device is inserted.

VPN CLIENT
When the Connection Manager connects to the 3G network, 
VPN setup wizard allowing you to configure the VPN 
settings.

THE OPTIONS MENU
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You may choose Microsoft VPN, or other provider listed on 
the “Use another client VPN”. Selecting Other will allow you  
to set your own VPN EXE and parameters.
n	� The option to enable and disable this feature needs to be in 

the IT Manager tool as well as the ability for the manager to 
setup the VPN parameters.

THE OPTIONS MENU



37

USING U.S. CELLULAR BROADBAND CONNECT

CONTROL PANEL
The control panels are accessed though the menu of 
connection manager. This section allows users to open 
new windows for details on their device and about their 
computer.

Modem will open the computer phone and modem details.

Network and Dial-Up Connection will open computer 
Network Connection Page. 

Internet will open the Windows Internet Properties page.

All will open the computer Control Panel.

■ THE OPTIONS MENU

UPDATE PRL
Connection Manager must provide an option to initiate and 
terminate OTASP sessions. An activation status is required. 
The status will display to users that their device is activating. 
Activation must be run automatically. This is required based 
on the reading of the device state for NAM. The menu 
option for activation is Options > Update PRL.

THE OPTIONS MENU
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MODEM ACTIVATION
Modem activation page displays a window where the user 
can enter information about his/her device. The fields are:

•	 ESN –  This is not editable
•	 MEID Dec –  This is not editable
•	 pESN Hex –  This is not editable
•	 Activation Code
•	 Phone Number
•	 MIN
•	 SID

POWER ON/OFF WWAN DEVICE
This is used to power the on/off Wireless Internet Card.

THE OPTIONS MENU
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USING U.S. CELLULAR BROADBAND CONNECT

■ THE HELP MENU
The U.S. Cellular Broadband Connect has a Help section. 
Please see the Help section for additional information.

LIVE UPDATE
The Software offers a live update wizard that allows the 
application to be kept up to date.  The Live Update wizard 
is a separate application that is integrated into Connection 
Manager.  The application searches on the Internet for new 
updates based on version numbers and will download and 
install the update.  This application can be run manually or 
automatically and is launched from the Start menu.

THE HELP MENUTHE HELP MENU
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GUIDE
Shortcut to the user guide.

HELP TOPICS
Launches this help file.

THE HELP MENU
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ABOUT DEVICE
About device will have the following Information.

ABOUT U.S. CELLULAR BROADBAND CONNECT

THE HELP MENU
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REGULATORY AND  
SAFETY INFORMATIONS

■ REGULATORY NOTICES 
UM185US complies with Parts 15, 22, and 24 of the FCC 
rules. It has been tested with a typical personal computer 
with a USB port. This USB device must not be co-located 
or operated in conjunction with any other antenna 
or transmitter. If you use this USB device in any other 
configuration, the FCC RF Exposure compliance limit can be 
exceeded.

■ OPERATING CONDITIONS 
1	 This device may not cause harmful interference and must 

accept any interference received, including interference 
that may cause undesirable operations.

2	 The manufacturer stipulates that the antenna should be 
more than 1.5 cm (0.60”) from by-standers and 1.0cm 
(0.39”) from the user. 

REGULATORY NOTICES
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■ WARNINGS AND CAUTIONS 
1	 Modifying or changing this USB device without express 

authorization can nullify compliance with RF exposure 
guidelines.

2	 This USB device has been tested and found to comply 
with the limits pursuant to Part 15, 22, and 24 of the FCC 
Rules. These limits are designed to provide reasonable 
protection against harmful interference when 
appropriately installed. This USB device generates, uses, 
and can radiate radio frequency and, if not installed and 
used according to the instructions provided, it may cause 
harmful interference to radio communication. However, 
there is no guarantee that interference will not occur in 
any particular installation.

3	 If this USB device does cause harmful interference with 
radio or television signals (determine this by turning 
the USB device off and on), attempt to correct the 
interference by trying one or more of the following: 

	 •  Reorient or relocate the antenna.

	 •  �Increase the separation between the USB device and 
receiver.

	 •  �Connect the USB device into an outlet on a circuit 
different from that to which the receiver is connected.

	 •  �Consult the dealer or an experienced radio/TV 
technician for help.

4	 This USB device does not exceed the Class B limits for 
radio noise emissions from digital apparatus as set out 
in the interference causing equipment standard entitled 
“Digital Apparatus”, ICES-003 of the Department of 
Communications. 

WARNINGS AND 
CAUTIONS
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5	� If you have purchased this product under a United States 
Government  contract, it shall be subject to restrictions 
as set forth in subparagraph (C)(1)(ii) of Defense Federal 
Acquisitions Regulations (DFARs) Section 252.227-7013 
for Department of Defense contracts, and as set forth 
in Federal Acquisitions Regulations (FARs) Section 
52.227-19 for civilian agency contracts or any successor 
regulations. If further government regulations apply, 
it is your responsibility to ensure compliance with such 
regulations. 

■ SAFETY PRECAUTIONS  
1	 Data transmission and reception cannot be guaranteed 

because of the nature of wireless communications. Data 
can be delayed, corrupted or lost during transmission. 
Even though it is quite rare that significant data delay or 
loss occurs if the USB device is used in a normal manner, 
this USB device should not be used in cases where data 
transmission or reception failure could result in damage 
of any kind to the user or another party, including but 
not limited to personal injury, death or loss of personal 
property. Personal Communications Devices, LLC. bears 
no responsibility for damages or losses of any kind 
resulting from delays or errors in data transmission 
using the USB device, or for failure of the USB device to 
transmit or receive such data.

2	 Do not use this USB device in areas where blasting is in 
progress, where explosive atmospheres may be present, 
near medical equipment, life support equipment, or 
any equipment which may be susceptible to any form 
of radio interference. Turn off this USB device in these 

SAFETY PRECAUTIONS
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SAFETY INFORMATIONS

areas, since it can transmit signals that could interfere 
with this equipment.

3	 Do not use this USB device in any aircraft whether the 
aircraft is on the ground or in flight. Make sure to turn 
off this USB device in aircraft. If used in an aircraft, it can 
transmit signals that could interfere with various aircraft 
systems.

4	 Do not use this USB device while driving a car, since 
it can distract the driver. In some areas, using the 
communication device while driving a car is illegal.

* WARNING:  �This product contains a chemical known to the 
State of California to cause cancer.

* WARNING:  �This product contains a chemical known to the 
State of California to cause birth defects or 
other reproductive harm.

SAFETY PRECAUTIONS
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■ GLOSSARY

Analog Coverage
An area where analog service is available. Analog phones 
usually indicate signal strength on an indicator in the 
phone’s display when receiving an analog signal. 

Browser
The software that allows you to view the Internet; contains 
navigator commands such as forward and back; examples 
include Netscape, Microsoft Explorer. A Web browser in your 
computer requests HTML files from Web servers and takes 
you to the Internet sites you wish to visit, by linking your 
computer’s IP address to a site’s IP address. 

COM PORT (communications port)
A connector for a communications interface, usually, a serial 
port.

Data
Information kept in databases, on an intranet, on the 
Internet, etc. 

Driver
Software that controls a device.  

Inactivity Time-Out
A stoppage in a connection, which usually occurs after a 
period of time elapses, without activity. Time-out settings 
are usually determined by the network. 

GLOSSARY
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Internet
A cooperatively run, globally distributed collection of 
computer networks that exchange information via a 
common set of rules for exchanging data (Transfer Control 
Protocol/Internet Protocol or TCP/IP).

Intranet
An intranet is a web site created by a business, which 
posts its own company information in a secure part of the 
Internet that only employees or other authorized users can 
reach. Intranets are generally protected by firewalls. 

Kbps
Kilobits per second. 

Kilobyte (KB)
1024 bits (approximately 1/2 page of plain text). 

Modem
Hardware that translates and transmits data over wire-line 
or wireless.

Package Minutes
Package minutes are those minutes included in the cost of a 
monthly service plan. Once the packaged minutes have been 
exhausted, additional airtime charges apply. Please refer to 
Plans and Pricing for more information, details and offers in 
your area.

Packet Switching
Packet-switching messages are divided into packets or 
pieces before transmission over one or more routes and are 
reassembled at their destination. 

GLOSSARY
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POP3 e-mail
Protocol used by ISP’s mail servers to manage e-mail for 
subscribers. E-mail clients such as Microsoft Outlook support 
POP3. 

Proxy Settings
A specific I.P. address that allows access to a secured 
enterprise network. The proxy settings provide directions 
to a computer so that it can locate an address and access 
information and services, which exist at that location. 

Search Engine
A program that receives a user’s search request, compares 
it to the entries in the index, and returns results to help the 
user find relevant information.

Serial Port
A connector on a computer used to connect peripherals, 
which communicate using a serial protocol. 

Serial/Data Cable
A wire that connects two serial ports carrying data to one 
another.

Transmission Speed
The rate at which data is sent over a communications line, 
usually measured in kilobits (kbps). 

USB Port
A connector on a computer to connect peripherals using 
USB (Universal Serial Bus) protocol. 

GLOSSARY
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■ SPECIFIC ABSORPTION RATES (SAR)
Maximum: 	SAR 1.19 W/kg CDMA835 Body  
	 SAR 0.854 W/kg PCS1900 Body

THIS MODEL DEVICE MEETS THE GOVERNMENT’S 
REQUIREMENTS FOR EXPOSURE TO RADIO WAVES.

Your wireless device is a radio transmitter and receiver. It 
is designed and manufactured not to exceed the emission 
limits for exposure to radiofrequency (RF) energy set 
by the Federal Communications Commission of the U.S. 
Government. These limits are part of comprehensive 
guidelines and establish permitted levels of RF energy 
for the general population. The guidelines are based on 
standards that were developed by independent scientific 
organizations through periodic and thorough evaluation 
of scientific studies. The standards include a substantial 
safety margin designed to assure the safety of all persons, 
regardless of age and health. The exposure standard for 
wireless device employs a unit of measurement known as 
the Specific Absorption Rate, or SAR. The SAR limit set by 
the FCC is 1.6 W/kg. *

Tests for SAR are conducted with the device transmitting 
at its highest certified power level in all tested frequency 
bands. Although the SAR is determined at the highest 
certified power level, the actual SAR level of the device 
while operating can be well below the maximum value. 
This is because the device is designed to operate at multiple 
power levels so as to use only the power required to reach 
the network. In general, the closer you are to a wireless 
base station antenna, the lower the power output. Before 
a device model is available for sale to the public, it must be 
tested and certified to the FCC that it does not exceed the 

SPECIFIC ABSORPTION 
RATES
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limit established by the government adopted requirement 
for safe exposure. The tests are performed in positions and 
locations (e.g., at the ear and worn on the body) as required 
by the FCC for each model. The highest SAR value for this 
model device when tested for use when worn on the body, 
as described in this user guide, is 1.19 W/Kg. (Body-worn 
measurements differ among device models, depending 
upon available accessories and FCC requirements). While 
there may be differences between the SAR levels of 
various device and at various positions, they all meet the 
government requirement for safe exposure. The FCC has 
granted an Equipment Authorization for this model device 
with all reported SAR levels evaluated as in compliance with 
the FCC RF exposure guidelines. SAR information on this 
model device is on file with the FCC and can be found under 
the Display Grant section of http://www.fcc.gov/oet/ea/fccid 
after searching on FCC ID: PP4PX-800.

Additional information on Specific Absorption Rates (SAR) 
can be found on the Cellular Telecommunications Industry 
Association (CTIA) web-site at http://www.ctia.org.

* �In the United States and Canada, the SAR limit for device 
used by the public is 1.6 watts/kg (W/kg) averaged over 
one gram of tissue. The standard incorporates a sub-
stantial margin of safety to give additional protection 
for the public and to account for any variations in 
measurements.

SPECIFIC ABSORPTION 
RATES
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■ SAFETY INFORMATION FOR RF EXPOSURE

BODY WORN OPERATION
This device was tested in multiple notebook computer 
configurations with USB port configurations for typical 
near-body operations with the back of the USB Modem 
kept 5mm from the body. To maintain compliance with 
FCC RF exposure requirements, it can be used in notebook 
computers with substantially similar physical dimensions, 
construction, electrical and RF characteristics, and that 
maintain a minimum 20mm separation distance between 
the user’s body and the back of the USB Modem, including 
the antenna. The antenna(s) used for this USB Modem must 
not be co-located or must not operate in conjunction with 
any other antenna or transmitter within a host device.

SAFETY INFORMATION
SAFETY INFORMATION FOR FIXED WIRELESS TERMINALS 
POTENTIALLY EXPLOSIVE ATMOSPHERES

Turn your device OFF when in any area with a potentially 
explosive atmosphere and obey all signs and instructions. 
Sparks in such areas could cause an explosion or fire 
resulting in bodily injury or even death.

INTERFERENCE TO MEDICAL DEVICES
Certain electronic equipment may be shielded against RF 
signal from your wireless device. (Pacemakers, Hearing Aids, 
and so on) Turn your device OFF in health care facilities 
when any regulations posted in these areas instruct you 
to do so. RF signals may affect improperly installed or 
inadequately shielded electronic system in motor vehicles.

SAFETY INFORMATION 
FOR RF EXPOSURE
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EXPOSURE TO RF ENERGY
Use only the supplied or an approved replacement antenna. 
Do not touch the antenna unnecessarily when the phone is 
in use. Do not move the antenna close to, or couching any 
exposed part of the body when making a call.

FCC COMPLIANCE INFORMATION
This device complies with Part 15 of FCC Rules.

Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and

(2) �This device must accept any interference received.  
This includes interference that may cause undesired 
operation.

SAFETY INFORMATION 
FOR RF EXPOSURE
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■ �U.S. FEDERAL COMMUNICATIONS COMMISSION 
RADIO FREQUENCY INTERFERENCE STATEMENT

INFORMATION TO THE USER
NOTE : This equipment has been tested and found to comply 
with the limits for a Class B digital device pursuant to Part 
15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful Interference in a 
residential installation. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user 
is encouraged to try to correct the interference by one or 
more of the following measures:

*- �Reorient or relocate the receiving antenna.  
Increase the separation between the equipment and 
receiver.

*- �Connect the equipment into an outlet of a circuit 
different from that to which the receiver is connected.

*- �Consult the dealer or an experienced radio/TV technician 
for assistance. 
Changes or modification not expressly approved by the 
party responsible for compliance could void the user’s 
authority to operate the equipment. Connecting of 
peripherals requires the use of grounded shielded signal 
cables.

U.S. FEDERAL COMUNICATIONS 
COMISSION RADIO FREQUENCY 

INTERFERENCE STATEMENT
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FCC ID: PP4PX-800

Warning: 
Exposure to Radio Frequency Radiation

The radiated output power of this device 
is far below the FCC radio frequency 
exposure limits. Nevertheless, the device 
should be used in such a manner that the 
potential for human contact during normal 
operation is minimized. In order to avoid 
the possibility of exceeding the FCC radio 
frequency exposure limits, human proximity 
to the antenna should not be less than 
20mm during normal operation. The gain 
of the antenna for wireless band must not 
exceed 3.5 dBi. The gain of the antenna for 
PCS band must not exceed 6 dBi. The gain 
of the antenna for AWS band must not 
exceed 6dBi.

U.S. FEDERAL COMUNICATIONS 
COMISSION RADIO FREQUENCY 
INTERFERENCE STATEMENT
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■ 12 MONTH LIMITED WARRANTY
Personal Communications Devices, LLC. (the “Company”) 
warrants to the original retail purchaser of this handheld 
portable cellular telephone, that should this product or any 
part thereof during normal consumer usage and conditions, 
be proven defective in material or workmanship that results 
in product failure within the first twelve (12) month period 
from the date of purchase, such defect(s) will be repaired 
or replaced (with new or rebuilt parts) at the Company’s 
option, without charge for parts or labor directly related to 
the defect(s).

The antenna, keypad, display, rechargeable battery and 
battery charger, if included, are similarly warranted for 
twelve (12) months from date of purchase.

This Warranty extends only to consumers who purchase 
the product in the United States or Canada and it is not 
transferable or assignable.

This Warranty does not apply to:

(a) �Product subjected to abnormal use or conditions, 
accident, mishandling, neglect, unauthorized alteration, 
misuse, improper installation or repair or improper 
storage;

(b) �Product whose mechanical serial number or electronic 
serial number has been removed, altered or defaced.

(c) �Damage from exposure to moisture, humidity, excessive 
temperatures or extreme environmental conditions;

(d) �Damage resulting from connection to, or use of any 
accessory or other product not approved or authorized 
by the Company; 

12 MONTH LIMITED 
WARRANTY
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(e) �Defects in appearance, cosmetic, decorative or structural 
items such as framing and non-operative parts;

(f) �Product damaged from external causes such as fire, 
flooding, dirt, sand, weather conditions, battery leakage, 
blown fuse, theft or improper usage of any electrical 
source.

The Company disclaims liability for removal or reinstallation 
of the product, for geographic coverage, for inadequate 
signal reception by the antenna or for communications 
range or operation of the cellular system as a whole.

When sending your wireless device to Personal 
Communications Devices for repair or service, please note 
that any personal data or software stored on the device 
may be inadvertently erased or altered. Therefore, we 
strongly recommend you make a back up copy of all data 
and software contained on your device before submitting it 
for repair or service. This includes all contact lists, downloads 
(i.e. third-party software applications, ringtones, games 
and graphics) and any other data added to your device.  In 
addition, if your wireless device utilizes a SIM or Multimedia 
card, please remove the card before submitting the device 
and store for later use when your device is returned, 
Personal Communications Devices is not responsible for and 
does not guarantee restoration of any third-party software, 
personal information or memory data contained in, stored 
on, or integrated with any wireless device, whether under 
warranty or not, returned to Personal Communications 
Devices for repair or service.

To obtain repairs or replacement within the terms of this 
Warranty, the product should be delivered with proof of 

12 MONTH LIMITED 
WARRANTY
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Warranty coverage (e.g. dated bill of sale), the consumer’s 
return address, daytime phone number and/or fax number 
and complete description of the problem, transportation 
prepaid, to the Company at the address shown below or to 
the place of purchase for repair or replacement processing.  
In addition, for reference to an authorized Warranty station 
in your area, you may telephone in the United States (800) 
229-1235, and in Canada (800) 465-9672 (in Ontario call 416-
695-3060). 

THE EXTENT OF THE COMPANY’S LIABILITY UNDER THIS 
WARRANTY IS LIMITED TO THE REPAIR OR REPLACEMENT 
PROVIDED ABOVE AND, IN NO EVENT, SHALL THE 
COMPANY’S LAIBILITY EXCEED THE PURCHASE PRICE PAID 
BY PURCHASER FOR THE PRODUCT.

ANY IMPLIED WARRANTIES, INCLUDING ANY IMPLIED 
WARRANTY OF MERCHANTABILITY OR FITNESS FOR 
A PARTICULAR PURPOSE, SHALL BE LIMITED TO THE 
DURATION OF THIS WRITTEN WARRANTY. ANY ACTION 
FOR BREACH OF ANY WARRANTY MUST BE BROUGHT 
WITHIN A PERIOD OF 18 MONTHS FROM DATE OF 
ORIGINAL PURCHASE.  IN NO CASE SHALL THE COMPANY 
BE LIABLE FOR AN SPECIAL CONSEQUENTIAL OR 
INCIDENTAL DAMAGES FOR BREACH OF THIS OR ANY 
OTHER WARRANTY, EXPRESS OR IMPLIED, WHATSOEVER.  
THE COMPANY SHALL NOT BE LIABLE FOR THE DELAY IN 
RENDERING SERVICE UNDER THIS WARRANTY OR LOSS OF 
USE DURING THE TIME THE PRODUCT IS BEING REPAIRED OR 
REPLACED.

No person or representative is authorized to assume for 
the Company any liability other than expressed herein in 
connection with the sale of this product.

12 MONTH LIMITED 
WARRANTY
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Some states or provinces do not allow limitations on 
how long an implied warranty lasts or the exclusion or 
limitation of incidental or consequential damage so the 
above limitation or exclusions may not apply to you. This 
Warranty gives you specific legal rights, and you may also 
have other rights, which vary from state to state or province 
to province.

IN USA:  �Personal Communications Devices, LLC.
555 Wireless Blvd. 
Hauppauge, New York 11788 
1-800-229-1235

IN CANADA:  �PCD Communications Canada Ltd.
5535 Eglinton Avenue West, Suite 234 
Toronto, Ontario M9C 5K5 
1-800-465-9672

12 MONTH LIMITED 
WARRANTY


